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NEW QUESTION 1
- (Exam Topic 1)
You need to provide all app components of the application to Tailwind Traders. What should you do?

A. Package the application and flow components into a single solution for export.
B. Run the app checker and flow checker prior to publishing each component for export.
C. Export each component separately but use the same version number for each component.
D. Publish the application and flow solutions at the same time before exporting each one.

Answer: B

Explanation: 
Scenario: When identifying versions of the app solution, all dependencies, entities, and user interfaces components must be identified to avoid any unintentional
issues caused by reverting individual components to a previous version.
Power Apps has added components to the rule set that encourages best practices in the Power Apps Checker. You can check your canvas apps and flows that
are included in solutions and then review all issues in a single, consolidated report.
Reference:
https://docs.microsoft.com/en-us/power-platform-release-plan/2019wave2/microsoft-powerapps/checker-include

NEW QUESTION 2
- (Exam Topic 1)
You publish the first version of the app and solution on November 1, 2020. You need to create the version numbers for the app and the solution.
Which version numbers should you use? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: 1.0.0.0
When identifying versions of the app solution, all dependencies, entities, and user interfaces components must be identified to avoid any unintentional issues
caused by reverting individual components to a previous version.
A solution’s version has the following format: major.minor.build.revision. An update must have a higher major, minor, build or revision number than the parent
solution. For example, for a base solution version 3.1.5.7, a small update could be a version 3.1.5.8 or a slightly more signficant update could have version 3.1.7.1.
A substantially more significant update could be version 3.2.0.0.
Box 2: 20.11.1.1
Scenario:

 You must use the following version control numbering scheme:
- Major: The last two digits of the year the app is packaged
- Minor: Two digits that represent the month when the app is packaged
- Build: A number that is incremented to represent significant changes to the app
- Revision: The incremented revision for a package
New versions of the application must completely replace previous versions of the app. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/common-data-service/update-solutions

NEW QUESTION 3
- (Exam Topic 1)
You need to configure the app to meet the requirements.
Which object properties should you configure? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Fill
Scenario: You must display a visual indicator in the app so that sales representatives know whether the app is offline before submitting reports.
Fill – The background color of a control. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/controls/control-screen https://docs.microsoft.com/en-us/powerapps/maker/canvas-
apps/functions/function-form

NEW QUESTION 4
- (Exam Topic 1)
You need to provide the app to Tailwind Traders. What should you do?

A. Within Managed Properties, set the value of the Allow customizations option to tru
B. Export the app as a managed solution.
C. Use the Share App feature.
D. Within Managed Properties, set the value of the Allow customizations option to fals
E. Export the app as a managed solution.
F. Within Managed Properties, set the value of the Allow customizations option to fals
G. Export the app as an unmanaged solution.

Answer: C

Explanation: 
Scenario: The completed app and all supporting components must be provided to Tailwind Traders. Tailwind Traders must not be able to make changes to any of
the components.
Managed Solution: A managed solution is a finalized solution that can be distributed and installed. They are created by exporting an unmanaged solution by setting
restrictions to prevent any further customizations. The whole point of Managed is locking down the Component states so they cannot be edited. Deleting the
Managed Solution will remove all its customisations as well as data contained. Managed Solutions become read only once deployed so they cannot be
manipulated.
Reference:
https://powerusers.microsoft.com/t5/Power-Apps-Pro-Dev-ISV/Managed-vs-Unmanaged/td-p/495685

NEW QUESTION 5
- (Exam Topic 2)
You need to implement the change requested by the operations manager. Which control should you use?
BF70D5D

A. Camera
B. Shape
C. Add picture
D. Image

Answer: D

Explanation: 
Scenario: The operations manager asks that the time tracking app display the employee’s photo once they have scanned their badge.
Image control in Power Apps is a control that shows an image from, for example, a local file or a data source. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/controls/control-image

NEW QUESTION 6
- (Exam Topic 2)
You need to create the solution assets.
What should you use to create the visualizations? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: PowerBI Desktop
The Sales dashboard must reside in the Sales channel and must include information about active quotes, sales pipeline, and year-to-date sales KPIs for sales
quotas by region.
PowerBI Desktop to support many data source. Box 2: PowerBI Desktop or Power BI Service on
A dashboard that shows a capacity Heat map by month as well as expected sales that are likely to close for the next month.
Both support visualizations. Reference:
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-service-vs-desktop

NEW QUESTION 7
- (Exam Topic 3)
You are creating an app for an organization’s human resources (HR) department. You create an Employee entity in an unmanaged Common Data Service
solution.
Another user creates the following Power Automate flows separately from the solution:

You need to incorporate the flows that can be added to the solution.
Which two flows can you include? Each correct selection presents a complete solution.
NOTE: Each correct selection is worth one point.

A. FlowA
B. FlowB
C. FlowC
D. FlowD

Answer: AD

Explanation: 
You can add any of these conditions to determine precisely when your flow is triggered.
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Reference:
https://docs.microsoft.com/en-us/power-automate/connection-cds-native

NEW QUESTION 8
- (Exam Topic 3)
You are creating a model-driven app that allows users to create and edit a list of existing accounts. You need to display a list of all active accounts.
Which user interface components should you use?

A. view
B. gallery
C. data table
D. form

Answer: C

Explanation: 
Imagine that you have a collection of data (such as a list sales orders, a set of service tickets, or a directory of contacts), and that you want to show this data in
your Microsoft PowerApps app in a tabular format, where each column represents a field and each row represents a record. In the past, you might have been able
to roughly simulate this visualization, although the process required some effort. However, we’ve been listening to your requests and are happy to announce that
you can now quickly and easily achieve this very typical visualization by using the new Data table control that has been recently added to PowerApps.
Reference:
https://powerapps.microsoft.com/fr-fr/blog/introducing-the-data-table-control/

NEW QUESTION 9
- (Exam Topic 3)
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You are creating a canvas app that displays a list of accounts.
Users must be able to select an account and view details for the account. The app must include a feature that brings the user back to the list of accounts.
You add a blank screen named Screen_Accounts and add a gallery named Gallery_Accounts to the screen. You set the data source of Gallery_Accounts to
Accounts and add another blank screen named Screen_AccountDetail.
You need to complete the app. Solution:

 Add a display form to Screen_AccountDetail.

 Set the OnSelect property of Gallery_Accounts to Navigate(Screen_AccountDetail).

 Set the data source of the form to Accounts.

 Set the Item property of the form to Selected.

 Add a back icon on Screen_AccountDetail and set its OnSelect property to Navigate(Screen_Accounts). Does the solution meet the goal?

A. Yes
B. No

Answer: A

Explanation: 
If you add a Display form control, the user can display all fields of a record or only the fields that you specify. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/controls/control-form-detail

NEW QUESTION 10
- (Exam Topic 3)
You create a canvas app.
A user is not able to determine which field currently has focus. You run App checker to identify errors. You need to verify that the focused border thickness is set to
a value greater than zero.
Which section of the App checker results should you check?

A. Rules
B. Performance
C. Accessibility
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D. Runtime

Answer: C

Explanation: 
The Accessibility checker classifies each issue as an error, a warning, or a tip based the issue's severity. Issues include:

 Focus isn't showing
When the FocusBorderThickness of a control is set to 0. It is good practice to ensure a proper color-contrast ratio between the focus border and the control itself
so it's clearly visible.
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/accessibility-checker

NEW QUESTION 10
- (Exam Topic 3)
You plan to create apps for a company.
You need to identify the Power Platform tools required.
What should you use? To answer, drag the appropriate tools to the correct requirements. Each tool may be used once, more than once, or not at all. You may
need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Canvas App
Box 2: Model-driven app
Model-driven app design is a component-focused approach to app development. Model-driven app design doesn’t require code and the apps you make can be
simple or very complex. Unlike canvas app development where the designer has complete control over app layout, with model-driven apps much of the layout is
determined for you and largely designated by the components you add to the app.
Box 3: Power Automate
Power Automate is a service that helps you create automated workflows between your favorite apps and services to synchronize files, get notifications, collect
data, and more.
Box 4: Power Virtual Agents bot
When you create bots with Power Virtual Agents, you author and edit topics.

NEW QUESTION 14
- (Exam Topic 3)
You create a canvas app named Hardware Order that suggests computer hardware to customers.
A value must be entered for the EmployeeID field when creating a new order if the value in the OrderType field does not contain the prefix test.
You need to configure the business rule.
Which two actions should you perform? Each correct answer presents part of the complete solution.
NOTE: Each correct selection is worth one point.

A. Set the scope of the business rule to Entity.
B. Add a Recommendation action and configure it to enter the order type.
C. Set the scope of the business rule to All Forms.
D. Use the following condition expression:(OrderType Does not begin with [test]) AND (Modified By Does not contain data)

Answer: AD

Explanation: 
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/common-data-service/data-platform-create-business-rule

NEW QUESTION 17
- (Exam Topic 3)
You need to set the value for a global variable named RunningTotal to 5 and navigate to the previous screen named MainScreen.
Which formula should you use?

A. UpdateContext( { RunningTotal: 5 } ); Navigate( MainScreen, ScreenTransition.Cover, RunningTotal );
B. If( Value(TextBox1.Text) >= 0, (Set( RunningTotal, 5); Back();), Color.Green )
C. UpdateContext( { RunningTotal:5 } ); Back()
D. Set( RunningTotal, 5 ); Back();

Passing Certification Exams Made Easy visit - https://www.surepassexam.com



Recommend!! Get the Full PL-100 dumps in VCE and PDF From SurePassExam
https://www.surepassexam.com/PL-100-exam-dumps.html (153 New Questions)

Answer: D

Explanation: 
You set the value of the global variable with the Set function. Set( MyVar, 1 ) sets the global variable MyVar to a value of 1.
Use the Back and Navigate function to change which screen is displayed. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/working-with-variables https://docs.microsoft.com/en-us/powerapps/maker/canvas-
apps/functions/function-navigate

NEW QUESTION 22
- (Exam Topic 3)
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You build a canvas app for a manufacturing company. The company receives parts and materials from many vendors. You create a form to collect information
from packing slips.
Receivers must be able to take a picture of packing slips to receive materials instead of manually entering data in the app.
You need to ensure that users can scan packing slip information into the form. Proposed solution: Use a Key Phrase Extraction model.
Does the solution meet the goal?

A. Yes
B. No

Answer: B

Explanation: 
The key phrase extraction prebuilt model identifies the main points in a text document. Reference:
https://docs.microsoft.com/en-us/ai-builder/prebuilt-key-phrase

NEW QUESTION 25
- (Exam Topic 3)
You create a canvas app.
You need to make the app available to other people in your company.
What are two possible ways to achieve the goal? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. Grant access to individual users in your company.
B. Share the app with a Microsoft Exchange distribution list.
C. Grant access to a Microsoft Teams team.
D. Share the app with a Microsoft Azure Active Directory security group.

Answer: AD

Explanation: 
After you build a canvas app that addresses a business need, specify which users in your organization can run the app and which can modify and even reshare it.
Specify each user by name, or specify a security group in Azure Active Directory.
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/share-app

NEW QUESTION 28
- (Exam Topic 3)
You have the following Common Data Service entities: BusinessContracts and BusinessAccounts. You need to configure an N:N relationship between the two
entities.
Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Step 1: Open the relationship tab of the BusinessContracts entity. View entity relationships
From the Power Apps portal, select either Model-driven or Canvas design mode. Select Data > Entities and select the entity that has the relationships you want to
view. With the Relationships tab selected, you can select the following views:
Step 2: Select Add relationship.. Create relationships
While viewing entity relationships, in the command bar, select Add relationship and choose Many-to-many. Step 3: Select the BusinessAccounts entity as the
related entity.
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Reference:
https://docs.microsoft.com/en-us/powerapps/maker/common-data-service/create-edit-nn-relationships-portal

NEW QUESTION 33
- (Exam Topic 3)
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You are creating a canvas app that displays a list of accounts.
Users must be able to select an account and view details for the account. The app must include a feature that brings the user back to the list of accounts.
You add a blank screen named Screen_Accounts and add a gallery named Gallery_Accounts to the screen. You set the data source of Gallery_Accounts to
Accounts and add another blank screen named Screen_AccountDetail.
You need to complete the app. Solution:

 Add an edit form to Screen_AccountDetail and set the Default Mode of the form to View.

 Set the OnSelect property of Gallery_Accounts to Navigate(Screen_AccountDetail).

 Set the data source of the form to Accounts.

 Set the Item property of the form to Selected.

 Add a back icon on Screen_AccountDetail and set its OnSelect property to Navigate(Screen_Accounts).
Does the solution meet the goal?

A. Yes
B. No

Answer: A

Explanation: 
View, edit, or create an item, save the contents, and reset the controls in an Edit form control. FormMode.View: The form is populated with an existing record but
the user cannot modify the values of the
fields.
This function is often invoked from the OnSelect formula of a Button or Image control. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/functions/function-form

NEW QUESTION 38
- (Exam Topic 3)
A company uses Power Automate and Power Apps to streamline business processes. You need to use AI Builder to analyze customer reviews of the company’s
products.
In which order should you perform the actions? To answer, move all actions from the list of actions to the answer area and arrange them in the correct order.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Step 1: Connect data to the model.
First create an AI Builder form processing model for the customer reviews you want to process.
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Step 2: Train the model. Step 3: Publish the model.
Step 4: Use the model in a Power Automate flow.
Once you train and publish the model, create a solution-aware flow in Power Automate. Reference:
https://powerapps.microsoft.com/en-us/blog/introducing-simplified-ai-builder-experience-in-power-automate/

NEW QUESTION 39
- (Exam Topic 3)
A company uses data loss prevention (DLP) policies. You have a Power Automate flow that posts Twitter mentions into a Microsoft SharePoint list.
You are not able to activate the flow. You need to troubleshoot the issue.
What are two possible reasons why you cannot activate the flow? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. You are not assigned the Power Platform Admin role.
B. You placed all connectors into the Business group within the DLP policy.
C. You placed all connectors into the Non-Business group within the DLP policy.
D. You are not assigned the Environment Admin role.

Answer: BD

Explanation: 
D: DLP policies are created in the Power Platform admin center. They affect Power Platform canvas apps and Power Automate flows. To create a DLP policy, you
need to be a tenant admin or have the Environment Admin role.
B: This table describes how the DLP policy you created affects data connections in apps and flows.
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Note: Any connector that resides in the Non-Business data group—such as Outlook.com—won't share data with apps and flows by using SharePoint or Salesforce
connectors. Facebook and Twitter connectors are altogether blocked from being used in any app or flow in non-test environments such as production or default
environments.
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/wp-data-loss-prevention

NEW QUESTION 42
- (Exam Topic 3)
You use a Microsoft SharePoint list to record information about customers.
You must perform a series of actions only when a new item is added to a SharePoint list. You need to configure a Power Automate flow.
Which trigger should you use?

A. When an item is created
B. When an item is created or modified
C. When a file is created (properties only)
D. For a selected item

Answer: A

Explanation: 
Trigger - When an item is created Triggers when an item is created.
MS Flow will trigger when an item is created in the list. It will return all list item properties which can be used in the Flow.
Reference:
https://www.c-sharpcorner.com/article/sharepoint-based-triggers-in-ms-flow-part-2/

NEW QUESTION 46
- (Exam Topic 3)
You are creating a multi-page canvas app that loads tabular data from an external data source. Once loaded, the data must be available to all screens within the
canvas app.
You need to reduce the number of times that the app must retrieve data from the data source. Which two data stores can you use? Each correct answer presents
a complete solution. NOTE: Each correct selection is worth one point.

A. parameter
B. global variable
C. collection
D. environment variable

Answer: CD

Explanation: 
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/working-with-data-sources

NEW QUESTION 51
- (Exam Topic 3)
You are an app maker.
You want to create apps and track customizations as part of the default solution. You need to determine the impact of performing the work in the default solution.
What should you conclude?

A. The default solution does not contain all components and customizations from all solutions in the environment.
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B. The prefix used when creating components as part of the default solution can be set to a specific value.
C. The default solution cannot be exported and distributed to another environment.

Answer: C

Explanation: 
Default Solution. This is a special solution that contains all components in the system. The default solution is useful for discovering all the components and
configurations in your system.
Why you shouldn't use the default solutions to manage customizations
There are a few reasons why you shouldn't create apps and make customizations in either of the default solutions:

 The default solution can't be exported; therefore, you can't distribute the default solution to another
environment.
The default solution contains all components and customizations from all solutions in the environment.
By default, all enabled users can create apps and customize components in the Common Data Services Default Solution.
It's difficult to locate or identify the customizations you've made in the environment by using either default solution.
When you use either default solution to create components, you'll also use the default publisher assigned to the solution. This often results in the wrong publisher
prefix being applied to some components.
Reference:
https://docs.microsoft.com/en-us/power-platform/alm/use-solutions-for-your-customizations

NEW QUESTION 52
- (Exam Topic 3)
You create an app with multiple screens.
Test users report that the size and type of gallery displayed on each screen are different. You must improve the consistency for the app screens.
You need to create a reusable gallery that displays information based on the current record.
Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.
NOTE: More than one order of answer choices is correct. You will receive credit for any of the correct orders you select.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Step 1: Add a gallery control Add a gallery to a blank screen
* 1. On the Insert tab, select Gallery, and then select Vertical.
* 2. On the Properties tab of the right-hand pane, open the Items list, and then select your Gallery Step 2: Add a screen
Add a gallery in a screen
* 1. On the Home tab, select New screen > List screen.
A screen that contains a Gallery control and other controls, such as a search bar, appears. Step 3: Add an input property
Input property is how a component receives data to be used in the component. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/add-gallery https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/create-component

NEW QUESTION 54
......
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